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Foundation Course – 3
INFORMATION & COMMUNICATION TECHNOLOGY –1 (ICT-1)

Computer Fundamentals and Office Tools
Common for all DegreeProgrammes

II Semester
(30 Hours of Teaching Learning including Lab)

Unit-I:
Basics of Computers :Definition of a Computer - Characteristics and Applications 
of Computers – Block Diagram of a Digital Computer – Classification of Computers 
based on size and working – Central Processing Unit – I/O Devices.

Unit-II: 
Primary, Auxiliary and Cache Memory – Memory Devices. Software, Hardware, 
Firmware and People ware – Definition and Types of Operating System – Functions
of an Operating System – MS-DOS – MS Windows – Desktop, Computer, 
Documents, Pictures, Music, Videos, Recycle Bin, Task Bar – Control Pane.

Unit-III: 
MS-Word 
Features of MS-Word – MS-Word Window Components – Creating, Editing, 
Formatting and 
Printing of Documents – Headers and Footers – Insert/Draw Tables, Table Auto 
format – 
Page Borders and Shading – Inserting Symbols, Shapes, Word Art, Page Numbers, 
Equations – Spelling and Grammar – Thesaurus – Mail Merge

Unit-IV: 
MS-PowerPoint 
Features of PowerPoint – Creating a Blank Presentation - Creating a Presentation 
using a 
Template - Inserting and Deleting Slides in a Presentation – Adding Clip 
Art/Pictures -Inserting Other Objects, Audio, Video - Resizing and Scaling of an 
Object – Slide Transition – Custom Animation

Unit-V: 
MS-Excel 
Overview of Excel features – Creating a new worksheet, Selecting cells, Entering 
and editing Text, Numbers, Formulae, Referencing cells – Inserting Rows/Columns
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–Changing column widths and row heights, auto format, changing font sizes, 
colors, shading.

Reference Books: 1. Fundamentals of Computers by ReemaThareja, Publishers : 
Oxford University Press, India 2.Fundamentals of Computers by V.Raja Raman, 
Publishers : PHI 3. Microsoft Office 2010 Bible by John Walkenbach, Herb Tyson, 
Michael R.Groh and FaitheWempen, Publishers : Wiley

Unit-I
Computing  is  an important  part  of  everyday  life  in  the twenty-first  century.  From
music and photos to banking and communicating, computers have changed the way
we work and live. 

Introduction to computers:
• Computers are seen everywhere around us, in all spheres of life.
• May it be the field of education and research, travel and tourism, weather 

forecasting, social networking, Ecommerce or any other?
• Computers have now become an essential part of our lives.
• The growth of computer industry started with the need for performing fast 

calculations.
• The journey that started from the first calculating device i.e. Abacus 
1. Abacus: 

 It is the earliest computing device.
 It consist leads on a wire counting frame 
 Developed in china
 Between 1000 BC – 3500 BC
 Addition and multiplication of numbers was done by using abacus

2. Napier’s Logs and Bones 
 By John Napier, a Scottish mathematician
 In 1617
 Used to calculate products and quotients of large numbers.

3. Pascal adding machine 
 By Blaise Pascal, a French mathematician In 1642.
 First calculator for multiplication.
 Also called Pascline.

4.Gottfried Von Leibnitz’s Calculating machine 
 In 1673 Gottfried Leibnitz, a German mathematician.
 Extended the capabilities with Modified Pascal Machine.
 Adding, subtraction, multiplication, division.

5  . Difference engine and Analytical Engine   
 By Charles Babbage, an English mathematician, In 1822
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 Calculate various mathematical functions, do polynomial evaluation by finite
difference and theoretically could also solve differential equations.

6. Analytical engine 
 Thereafter in 1833, he designed the Analytical Engine which later on proved 

to be the basis of modern computer. 
 This machine could perform all the four arithmetic operations as well as 

comparison.
 It included the concept of central processor, memory storage and input-

output devices.
 Even the stored information could be modified.
 Although the analytical engine was never built that time but Babbage 

established the basic principles on which today’s modern computers work.
 Both these great inventions earned him the title of ‘Father of Modern 

Computers’. 

7. First electronic Digital Computer –ENIAC 
 ENIAC (Electronic numerical integrator and Calculator)
 By John W. Machanly & Association, In 1942-46.
 Vacuum tubes 180000, Weight 30tones, Space 1500sq. feet.
 Limited storage capacity.
 2000 KW of electricity to operate
 300 multiplications per second (performance)
 I/ O were three punched cards.

8. First stored program computer – EDSAC 
 EDSAC (electronic delayed storage automatic computer).
 By John Von Neumann, In 1947-49.
 Mercury delay line storage system.
 Input: Punched paper tape.
 Output: Tele printer.

9. EDVAC (Electronic discrete variable automatic computer) 
 From Pennsylvania University, In 1949
 Used in army

10. First automatic computer 
 UNIAC (universal automatic computer) 
 Installed by the American Bureau of census, in 1952.
 I/ O: Magnetic Tape.
 Handle Numbers and descriptive material.

Summary:
 ABACUS was the first calculating machine which was introduced by Chinese

around  3000  B.C.  This  was  a  huge  machine  used  for  only  additions  and
multiplications but on large amount of data.
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 In 1842 Charles Babbage invented an “Analytical Engine” which is treated as
base of modern computers. So, He is called as “Father of Computers”.

 In 1946 there was an invention of first electronic calculating machine called
ENIAC (Electronic Numerical Integrator Calculator).

 In  1951 the  first  automatic  computer  was  introduced  and called  as  UNIAC
(Universal Automatic Computer) was developed.

 In 1952 EDVAC (Electronic discrete variable automatic computer) was developed
by John- Von – Neumann on the “stored program” concept.  

Definition  :  Computer is an electronic device that takes raw data as input from the
user and processes these data and gives the result (output) and saves output for the
future use. It can process both numerical and non-numerical (arithmetic and logical)
calculations. 

A computer has four functions:
a. Accepts data        Input
b. Processes data      Processing
c. Produces output    Output
d. Stores results     Storage

Computer characteristics:

i) Speed: 
 Computer performs calculations at a greater speed when compared with other

calculating devices. 
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 Normal person may have taken a few minutes to calculate the operation, but in
the case of computer system it can perform operations within seconds.  

 The computer has units of speed in microsecond, nanosecond and even the
picoseconds.

ii) Accuracy: 

 In addition to being very fast, computers are very accurate.

 The computer has performed calculations 100% error free.

 Computers perform all jobs with 100% accuracy.

 If the input data is wrong, then the output will also be wrong. It is called as
Garbage-In, Garbage-Out (GIGO).

iii) Data storage: 
 Computer has large storage capacity, which is called as memory. 
 It can store large amount of data and instructions in its memory. 

 Memory is a very important characteristic of computers.

 It can store any type of data such as images, videos, text, audio and any other
type.

iv) Diligence: 
 Unlike humans, computers never get tired of a repetitive task. 
 It can continually work for hours without creating errors. 

v) Versatility: 

 It is the ability to perform many operations without getting any tired. 

 Today, Computers are used in our daily life in different fields.

 For  Example,  computers  are  used  for  home  purpose,  business-purpose,
teaching, railways, banking, and medicine and so on.

vi) Automation:

 A Computer can perform a task without any user’s involvement. 
 The user just assign the task into the computer, it works automatically without 

any user involvement until the completion of task.

vii) Security: 
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 Computers provide powerful security for information or data.
 The data which is stored computers with password cannot be opened by others, 

until and unless the password is correct.

Computers are seen everywhere around us, in all spheres of life. Computers have now
become an essential part of our lives. Today, computers are widely used in fields such
as engineering,  health  care,  banking,  education and research,  travel  and tourism,
weather forecasting, social networking, Ecommerce and so on.

1. Government: Computers are used in government Organizations to keep records
on governmental actions.

2. Legal System: - Computers are used by lawyers to conduct case research. 
3. Retail Business:-Computers are used in retail shops to enter orders, calculate

costs and print receipts.
4. Sports:  - In sports, computers are used to identify weak players and strong

players by analyzing statistics.
5. Music: - All computers have Musical Instrument Digital Interface (MIDI) facility

to generate variety of sounds.
6. Movies:-  Computers  are  used  to  create  sets,  special  effects,  animations,

cartoons and videos etc.,
7. Hospitals: - Hospitals use computers to record information about patients like

admit time to exit time, Blood pressure, lab reports etc.
8. Weather Forecasting: - Weather forecasting is the process of predict the state

of the weather for a given location.
9. Education:  -  A  Computer  is  a  powerful  teaching  aid  and  acts  as  another

teacher in the classroom.
10. Online  Banking:  -  Now  a  day’s  bank  transactions  can  be  made

anywhere and anytime using computers.
11. Examinations: We can give online exams and get instant results. You

can check your examination results online.
12. Robots: - Robots are computer-controlled machines.  Robots are able to

perform various tasks, which could not be done by the humans. 
13. Defense: There is software embedded in almost every weapon. Software

is used for controlling the flight and targeting in ballistic missiles. Software is
used to control access to atomic bombs.

14. Desktop  publishing:-  With  desktop  publishing,  you  can  create  page
layouts for entire books on your personal computer.

15. Mathematical  Calculations:-  Thanks  to  computers,  which  have
computing speeds of over a million calculations per second we can perform the
biggest of mathematical calculations.
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Definition: Computer is an electronic device that takes raw data as input from the
user and processes these data and gives the result (output) and saves output for the
future use. It can process both numerical and non-numerical (arithmetic and logical)
calculations.

A general purpose computer has three main components. They are
1. Input unit
2. Central processing unit (C. P. U )
3. Out Put Unit

Input unit:  The units which are used to feed or give data are known as “INPUT 
UNITS”.
Ex: - Key board, Mouse, Joystick, CD, DVD, Scanner, Floppy, etc.

C.P.U: C.P. U stands for “Central Processing Unit”. This is used to process the data,
process the instructions which are given by the user. C.P.U has mainly three units.
They are

1. M.M.U (Main memory Unit )
2. C.U ( Control Unit )
3. A.L.U ( Arithmetic & Logical unit)

M.M.U:- “M.M.U” stands for “Main memory Unit”. This is used to store data. M.M.U is
also known as “primary memory”. Primary memory means, for the first time data will
be stored in M.M.U. M.M.U have mainly two types of memories.
1. ROM (Read Only Memory)
2. RAM (Random access Memory)
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C.U:- C.U stands for “control Unit” This is used to control the input and output along
with the processing of the computer. This is the main part of the computer. C.U is also
called as Heart of the computer.
A. L.U:- A.L.U stands for “Arithmetic & Logical Unit” This is used to perform all
types of calculations like arithmetic, scientific and logical calculations.

Output unit: The units which are used to get or extract the result from the given data
are known as OUTPUT UNITS.
Ex: - Monitor Printer, CD, DVD, Floppy, etc.

1. Based on operating principles (working) computers are classified into the 
below three types.

1. Digital computers
2. Analog computers
3. Hybrid computers

i) Analog computers: 

 Analog is the Greek word, which means similar.

  Analog computers operate by measuring instead of counting.

 In analog computers, the similarities between any two quantities are measured
by electrical voltages or current.

 The analog computers works on the supply on continuous electrical signals.

 The display is also continuous and its output is in the form of graphs. 

 These computers are powerful to solve differential equations.

   Ex: Thermometer, Speedometer, Petrol pump indicator, Multi meter

ii) Digital computers: 

 Digital computers operate essentially by counting.

 All quantities are expressed as discrete digits or numbers. 

 It is represented by binary notation in the form of 0’s and 1’s.

 Digital computers are much faster than analog computers

 These types of computers are useful for evaluating arithmetic expressions
and manipulations of data.

  Ex: Business, Research& Development.

iii) Hybrid computers: (Analog + Digital)
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 A computer that combines features of both analog and digital computer types is
called as Hybrid computer.

 The instruments used in medical science are in this category.

 Ex: Weather monitoring systems, Devices used in ICU, Research institutions.

2. Based on different sizes and capacities computers are classified into four 
types. They are:

1. Micro computers
2. Mini computers
3. Mainframe computers
4. Super computers

i) Micro computers: 
 Micro computers are small sized general purpose processing systems.
 These are designed for use by single user at a time.
 A micro computer is also called as a personal computer.

 These computers are very small and cheap compared to other computers.
 The first micro computers was designed by IBM in 1981 and named “IBM-PC”
  Generally  these  are  used  in  office,  banks,  and  business  and  in  all  small

organizations.

PCs can be classified into the following Categories.
Desktop Computer: A desktop PC is the most popular model. It can be placed on a
desk or table.  It is commonly used in homes and offices.
Laptop  Computer:  A  portable  computer  complete  with  an  integrated  screen  and
keyboard. It is generally smaller in size than a desktop computer and larger than a
notebook computer.
Workstations: Workstations are single user computers. It is a terminal or desktop
computer in a network. However, workstations are normally linked together to form a
local-area network. 

Network  computers  : These  computers  are  used  to  access  data  from  Internet  or
Intranet.
Handheld Computers: A hand-sized computer. Palmtops have no keyboard but the
screen serves both as an input and output device.
.  Ex:        Personal Digital Assistant (PDA), Cellular telephones, H/PC Pro device.21
ii) Mini computers: 

 Mini computers are medium sized systems which are more powerful and cost
than a micro computer. 

 The major difference is that the mini computer is a multi user multi processing
system. 
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 Generally, servers are comes in this category.
  These  computers  are  used  in  Business,  education,  hospitals,  government

organizations etc.

     Ex: IBM AS/400  , VAX 8842 etc.

iii) Mainframe computers: 
 Computers with large storage capacity and high speed of processing are called

as Mainframe computers. 
 In main frame computers input/output operations are very fast.
 These computers are very expensive and need a very large room with AC.
 These  Computers  are  used  in  large  organizations  such  as  banks,  airlines,

Universities etc.
 Mainframe  Computers  are  accessed  by  terminals  (PCs).   Terminals  are  two

types. They are
(i) Dumb Terminals:  These terminals consist of only monitor and keyboard,

but do not have CPU and memory.
(ii) Intelligent Terminals:  Intelligent terminals consist of monitor, keyboard

and CPU, but do not have memory.
    Ex: IBM 4300, IBM S/390, IBM 3090 series, CYBER 176 etc.
iv) Super Computer:

 A super  computer  contains  large  storage  capacity  and very  high  computing
speeds, which are at least ten times faster than other computers.

 The Super Computer is the fastest, most powerful and Expensive Computer.
 It  was  first  developed  in  the  1980’s,  process  to  solve  Complex  Scientific

problems.
 It can perform more than one Trillion calculations in a Second. It can support

thousands of users at the same time.
 These  computers  are  mainly  used  for  weather  forecasting,  nuclear  energy

research, aircraft design etc.
    Ex:   CRAY-1, CRAY-2, PARAM etc.

Input devices: 
The units which are used to feed or give data are known as “INPUT UNIT”. Input may
be in the form of text, images, audio, video etc. The following are the different input
devices.   
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1. Keyboard:
 A Keyboard is similar to the typewriter. 

 The key board is the main input device to enter text into the computer.
  It contains alphabets, digits, special characters, function keys, numeric keys and

some control keys.
 a) Alpha Numeric or Main Keypad:-  i.e alphabets (A to Z), and Digits (0 to 9).

b) Functional Keypad :-That contains 12  keys  (F1, F2,F3…..F12) 

c) Numerical Keypad :- The Numerical keypad contains digits( 0 - 9),  

d) Arrow keys: Direction Keys (   ↓  ↑ ) , Page Up, Page Down, Insert, Del etc.

2. Pointing devices: Pointing devices are used to move the pointer and select items on
screen. 
i) Mouse:

 A mouse is a pointing device. 
 Mouse is used to locate a particular position on the screen. 
 The mouse  has  two  buttons  (Left  Button,  Right  Button)  and a

scroll wheel.
 The mouse operations are Point, Click, Drag and Scroll.
 Mouse is three types: Mechanical, Optical and Wireless.
Mouse Operations:

 Point Place the mouse pointer over the word or the object.
 Click Press either left or right mouse button.
 Drag Move an object from one place to another.
 Scroll Rotating scroll wheel to view long documents.

3. Handheld devices:
A handheld device is a pocket-sized computing device. Joystick

(i)      Joystick:
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 A Joystick is a cursor control device, which is used for computer games,
and CAD/CAM applications. 

 It is used to move the cursor position on a CRT screen. 

 The joystick can be moved right or left, forward or backward.
4. Optical devices:
Optical  devices are also known as data-scanning devices.  It  uses “light”  to
detect different types of objects such as characters, marks, codes and images.
Image scanners: 
 A Scanner is used to capture images, printed text, photographs, etc., and

converts into digital images.
 The digital images can be edited and produced color images and Black-and-White

images.
5.   Audio/video Input devices:
 Audio Input devices are used to create or capture sound. 
o Ex: Micro Phones and CD players.
 Video input devices are used to create or capture video.

Ex: Digital camera and Web camera.

Output units:  The units which are used to get or extract the result from the given 
data are known as OUTPUT UNITS.

Soft copy devices:
Softcopy devices produce an electronic version of output. For example, the content of a
file display on the computer screen (monitor).
Features:

 The user can easily edit soft copy output.
 Searching of data in a soft copy is easy and fast.
 Distribution of softcopy is cheaper and fast.

(i)      Monitors:
 It is the most commonly used output device to display the information.
 Computer monitors are similar to the television screens.
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 The monitor is connected to video card placed on the motherboard.
 Monitors are three types

a) CRT(Cathode Ray Tube) monitors
b) LCD(Liquid crystal Display) monitors
c) Plasma monitors

(ii)     Projectors:
 A projector is a device that takes an image from a video source and displays it

on a big screen.
 Projector uses a bright light and lens to display images on the screen.
 Generally,  Projectors  are  used  for  projecting  movies,  images,

presentations etc.
 Projectors are classified in to two categories:

a) LCD (Liquid Crystal Display) projectors
b) DLP (Digital Light Processing) projectors 

(iii)             Speakers:
 Speakers are used to produce audio from computer.
 Speakers receive audio input either in analog form or digital form. 
 Analog speakers amplify the analog waves into sound waves.
 Digital  speakers  convert  the  digital  waves  to  analog  waves,  and  then

generate the sound waves.
Hard Copy devices: 
Hard  Copy  Output  devices  produce  a  physical  form  of  output.  For  example,  the
content of a file printed on paper. 
Features:

 A computer is not needed to see the output.
 Editing in the hard copy is difficult.
 Distribution of a hard copy is costly and slow.

(i)       Printers:
 Printers are used to print textual and graphical information on a paper.
 Printers are available in various sizes, speeds, and costs.
 Printers can be classified into two types:

a) Impact printers
b) Non-Impact printers
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a)

Impact Printers: 
These printers print characters by pressing an inked ribbon against the paper.

 Produce carbon copies.
 Slow and Print quality is poor.

     Dot Matrix Printers 
 Dot matrix printer prints characters in the “form of dots”. 
 In this printer, the “print head” strikes the “Ink ribbon” on the paper. 
 The “print head” consists of 9-pins or 24-pins to print the characters.

     Daisy Wheel Printers 
 In Daisy wheel printer, the “print head” is a “circular wheel”.
 To print a character, by rotating wheel and placing the character in front

of the ribbon.
     Line Printers:

 Line printers are High-speed impact printers, in which one line is printed at
a time.

 Generally, Line printers are used in data centers. 
b)      Non-Impact Printers: 

These printers “Print head” do not pressing the paper while printing. Non-printers
use either powder cartridge (Toner) or Ink cartridge.

 Print quality is good and Noiseless, fast.
 Ink cartridges are expensive.

     Inkjet Printers 
 In Inkjet printer, the “print head” has small Nozzles, also called “jets”. 
 The nozzles spray ink on the paper in the form of character shape.

     Laser Printers 
 In Laser printer, the “print head”consists of “Laser beams”. 
 A laser beam ‘draws’ the document on a drum.
 After the drum is charged , it is rolled in a toner.

(ii)     Plotters:
 A plotter is a special kind of Output device.
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 Plotters are used to print large size of images such as maps, blue print of the
structure etc. 

 Plotters are much more expensive than printers.
 Plotters are two types. They are 

a) Drum plotter
b) Flat bed plotters

a)      Drum plotter:
 A drum plotter is also known as “Roller Plotter”.
 Drum Plotters are used to produce very large papers upto 1 metre.
b)      Flat bed plotters:
 The paper is fixed on the flat surface of the plotter, and the pen is moved

to draw the image. 
 The size of the paper and image is limited

Unit-II

Memory:  Memory is an internal storage area in the computer, which is used to store
data and programs either temporarily or permanently.
Computer memory can be broadly divided into two groups  - 

 Primary memory 
 Secondary memory

1.     Primary memory:
 Primary memory is also called as “Main memory” or “Internal Memory”.
 Primary memory is the only type memory that is directly accessed by the CPU.
 Any data operated by the CPU, is stored in primary memory.
 There are two types of Primary memories. They are

a. Random Access Memory (RAM)
b. Read Only Memory (ROM)

PRIMARY MEMORY

          

        RAM                               ROM          CACHE

ICT Prepared by Mahesh MCA

1) Define memory. Write a short note on Primary memory.



ICT – I          Computer Fundamentals and Office Tools                       16

             SRAM                  PROM
                                          DRAM                              EPROM

                   EEPROM
i) Random Access Memory (RAM):

 RAM stands for “Random Access Memory”.
 We can store, read, modify and delete the data from RAM.
 RAM is also called “volatile memory” (or) “temporary memory”. Because when

the power switched off it losses their information.
 In RAM the data stored by the user at the time of operation during work.
 In RAM data can be modified, added, deleted, re-writing can do any operation 

during the work.

 There are 2 types of RAMs.
a) SRAM
b) DRAM

ii) Read Only Memory (ROM):
 ROM stands for Read Only Memory.
 The information stored in ROM is only for reading purpose.
 ROM is also called “permanent memory” (or) “Non-volatile memory”. Because

ROM holds always same data.
 ROM performs the  BIOS (Basic  Input  Output  System)  function  to  start  the

computer system.
 In ROM, the data stored by manufacturers at the time of manufacturing 

computers.
 In ROM, programs cannot be modified or do not allow any operations except 

read the information.

 There are 3 types of ROMs.
a) PROM(Programmable Read only memory)

b) EPROM(Erasable Programmable Read only memory)

c) EEPROM(Electrically Erasable Programmable Read only memory)

c ) Cache Memory:- 

 Cache memory is an intermediate storage between the CPU Registers and Main
memory.

 It is small and fastest memory  
 CACHE memories are accessed much faster than RAM.
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Secondary storage (also known as external memory or auxiliary storage) differs from
main memory in that it is not directly accessible by the CPU.

 Secondary storage devices are also called as “Auxiliary Storage devices”.
 These memories are used to store the data permanently. 
 Secondary storage devices hold data, even the computer is switched off.
 These memories are cheaper and high storage capacity than primary memory.

The following are the various types of secondary storage devices.
 Magnetic Tape
 Floppy Disk
 Hard Disk
  Optical Drives (CD, DVD)
  USB Flash Drives

i.                     Memory Cards

ii. Mass Storage Device

i. Magnetic Tape: 
 Magnetic Tape is a plastic ribbon with ½ inch wide, which is

available in reels, cassettes.
 In Magnetic Tape, data can be accessed sequentially.
 It  is  cheaper,  smaller  in  size,  less  weight,  can  store  large

amount of data.
 These storage devices are basically used as sequential access.
 These are much slower and easily damaged due to heat, dust and miss

handling.
ii. Floppy Disk: 

 A Floppy Disk is a flexible plastic disk, which contains a Magnetic
Disk.

 The magnetic Disk is coated with magnetic oxide.
 The storage capacity of Floppy Disk is 1.44MB.
 Data can be lost, if the disk is bended or removed while in use.

iii. Hard Disk: 
 A Hard Disk is a set of magnetic disks, stacked together.
 Each disk requires two R/W heads, one for each side.
 The data is stored on the surface of a disk in “Tracks” and “Sectors”.
 It stores large amount of data, which can be accessed randomly.
 Hard Disks are larger in size and heavier in weight.

Optical Drives:
 The Optical Drives are latest technology devices, that uses “Light Sensors” to

store the information.
 The Light Sensors are called “Lasers”.
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 Optical drives are most widely used and reliable storage devices.
 The most popular optical storage devices are:

a) CD-ROM
b) DVD-ROM

c) CD-R
d) CD-RW

a) CD-ROM:
  A CD-ROM can store large amount of data permanently.
  Once the data is stored on CD-ROM, it cannot be changed.
  The storage capacity of CD-ROM is 700MB.
  CDs are easily portable and transfer the data from one computer

to another.
b) DVD-ROM:

 DVD-ROM is similar to CD-ROM, but it stores large amount of
data.

 A  standard  DVD  can  store  seven  times  more  data  than  CD,
because of its multi-layer storage technique.

 The storage capacity of DVD-ROM is 4.7GB.
c) CD-R (Recordable):

 It is a blank disk that can be used by the user to store information.
 The process of writing data on the Optical Disk is called “Burning”.
 Once the data is stored on CD-R, it cannot be changed.
 They are more expensive than CD-ROM drives.

d) CD-RW (Rewritable):
 CD-RW is an erasable Optical disk.
 The user can write and over-write the data on CD-RW in multiple times.
 The CD-RW drive is expensive than CD-R drive.

i.      USB Flash Drives:
 USB-Flash drives are removable, rewritable and smaller drives.
 In 2010, the storage capacity of USB-Flash drive is 256GB. 
 Data will not be damaged , due to scratches and dust.
 It is a portable drive, easily carried in a pocket.

ii.      Memory Cards:
 Memory card is  a small  device that can store/delete files multiple

times.
 They are easily movable from one place to another place.
 It requires less power, having high storage capacity and faster access

data.
iii.      Mass storage device

 Mass  storage  refers  to  storing  enormous  amounts  of  data  in  a  persistent
manner.

 Mass storage devices can store up to several trillion bytes of data.
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 Have  high  data  storage  capacity,  are  easily  portable,  and  have  low  power
consumption.

 Commonly used devices are:
 Disk Array
 Automated Tape Library

It is a very high speed semiconductor memory which can speed up CPU. It acts as a 
buffer between the CPU and main memory. 

 Cache memory is random access memory (RAM) that a computer 
microprocessor can access more quickly than it can access regular RAM. 

 This is temporary. Generally the cache memory will be created in between the
C.P.U registers and memory unit.

C.P.U request

C.P.U response

The CPU uses cache memory to store instructions and data that are repeatedly 
required to execute programs, thereby improving the overall system speed and 
increasing the performance of the computer.
Working of the cache memory:
The CPU first checks whether the data or instruction is available in the cache memory.
If  it  is  not  present  there,  the  CPU reads  the  data  or  instructions  from the  main
memory into the processor registers and also copies it into the cache memory. When
the same piece of data/instruction is needed again, the CPU reads it from the cache
memory instead of the main memory.

Software: Software is a collection of programs.  A program contains set of instructions
to initiate the computer to perform some action. Software can be divided into two 
groups:

1. System Software
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3) Write about cache memory.

4) Define software. Explain various types of software.
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2. Application software
1. System Software: It controls the overall operation of the system. It is stored in the
computer's  memory  and  instructs  the  computer  to  load,  store,  and  execute  an
application. 
a)   Operating System Software: An operating system is system software that provides
an interface for a user to communicate with the computer.
Ex: DOS, Windows XP, Windows Vista, Unix/Linux, MAC/OS X etc.

b)  Language  Processors:  Language  processors  are  required  to  convert  these
instructions into machine language.
Ex:  Compiler, Interpreter and Assembler.
c) Utility Software:  These are another type of system software that bridge the gap
between the functionality of an operating system and the needs of users.
 Ex: Windows  Explorer  (File/Folder  Management),  Compression  Tool,  Anti-Virus

Utilities, Disk Defragmentation, Disk Clean, Backup, WinZip, Win RAR etc…
2. Application Software: The collection of programs used to solve the given problem 
statement is called the application software. 
a) Generalized Software: These are user friendly software written to provide user’s
very  general  needs  such  as  preparing  documents,  drawing  pictures,  database  to
manage data/information, preparing presentations, play games etc.
  Ex: Ms. Office 2003, Ms. Office 2007, Macromedia (Dreamweaver, Flash, Freehand),  

Adobe (PageMaker, Photoshop)
b)  Customized  (or)  tailored  Software: These  are  the  applications  that  are  or
developed to meet the specific requirements of an organization/institution.
Ex: School Management system, Inventory Management System, Payroll system, 
financial system etc.

Hardware: 
 Computer hardware refers to the physical parts or components of a computer. 
 Hardware of a modern personal computer:

 It  understand two basic positions i.e. “ On” and “Off”, these are Binary Forms

1. Monitor 2. Mother board 3. CPU 4. RAM 5. Expansion cards 6. Power supply
7. Optical disc drives 8. Hard disks drive 9. Keyboard 10. Mouse 11.  system  unit
(Graphic cards, sound cards, memory, mother board and chips), etc. 

 F  irmware:-

  Firmware is a software, that embedded in hardware
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5) Write about hardware, firmware and people ware.
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  We may think, Firmware is a Software for Hardware.

 Firmware is Stored in Non-Volatile memory devices such as ROM, EPROM etc

 It  is  an integral  part  of  electronic  devices  such  as  Optical  Drives,  Routers,

Scanners,  Traffic Lights,  Consumer Appliances,  Digital  Watches,  Computers,

Computer Peripherals, Mobile Phones, etc.

Middleware: 
 A set of data and tools that enables different applications to use the resources

and services in a network system. 
 Middleware is used in a client-server system, in client-server system client is a

computer that requests a service and server is a computer that provides the
service to the client.  

 For  example,  in  distributed  applications,  middleware  can  support  data
management by allowing programs written for accessing a particular database
to access other database.

 Similarly,  middleware  can  enable  communication  between  two  disparate
applications by providing messaging services.

Operating system is a program or software. It acts as an intermediary between the
user of a computer and computer hardware.  (OR)

 An  operating  system  is  a  set  of  programs  used  to  manage  the  resources  and
operations of computer. Operating system has some of the FUNCTIONALITIES like

1. CPU scheduling

2. Memory Management

3. I/O Management 

4. File management

5. Job scheduling

6. Data security and integrity

7. Error – handling
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6) What is operating system? Explain its functions.
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8. Handling job – to- job transition

1. CPU SCHEDULING (Process management):- Assignment of processors to different
tasks was being performed by the computer system.

2. MEMORY MANAGEMENT: - Allocation of main memory and other storage areas to
the system areas to the system programs as well as user programs and data.

3.  INPUT  –  OUTPUT  MANAGEMENT:  -  The  coordination  and  assignment  of  the
different input and output devices while one or more programs are being executed.

4. FILE MANAGEMENT:  -  The storage of  files on various storage devices and the
transfer of these files from one storage device to another.

5. JOB SCHEDULING: - It determines and maintains the order in which jobs are to be
executed in the computer system.

6. DATA SECURITY AND INTEGRITY: - It keeps different programs and data in such
manner that they do not interfere with each other. The operating system protects the
stored information from unauthorized users and denies them access data.

7. ERROR HANDLING:  -  Production of  dumps,  traces,  error  messages,  and other
debugging and error detecting aids.

8. HANDLING JOB – TO- JOB TRANSITION: - operating system selects new jobs for
execution according to the priority fixed.

According to generation of computers and uses of computers in the society, there are
various types of operating systems are to be prepared. The following are the basic
classification of operating system.
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7) Explain different types of operating systems.
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1. SINGLE USER OPERATING SYSTEM: - In this type of operating system one person
can operate the computer one time. We cannot run more than one application at the
same time. 
2. MULTI USER OPERATING SYSTEM: - This operating system allows many users to
work at any given time, and takes the best advantage of CPU. Here many users are
connected through different terminals, and each user works at his terminal. 
3.  MULTI  –  PROGRAMMING  OPERATING  SYSTEM:  -  This  operating  system  is
capable of executing multiple programs at given instance. This functionality is possible
by storing more than one program in primary/ main memory and CPU. The multi
programming operating system again classified according to their nature of execution
of programs.
a) TIME SHARING OR MULTI TASKING SYSTEM: - Multi tasking making computers
operate more efficiently and accomplishing more tasks in a given period of time.  This
technology was originally used for mini and main frame computers. Now, it is extended
to micro computers. This new system works by dividing the screen into many windows.
Each window can be used by the user to execute a distinct program. 
b) REAL TIME/ ONLINE OPERATING SYSTEM: - The concept of real time means that
the data is entered relatively quickly as they arise and updated information is available
without  loss  of  any  time  between  data  entry  and  information  retrieval.  An  input
transaction  in  microseconds  as  in  an  airline,  railway  reservation  and  drawing  of
currency from ATM centers.
C) BATCH PROCESSING SYSTEM: - This operating system executes various tasks in
batches,  not  as individual  tasks.  This system also accepts various tasks from the
users  and places  them in  queue waiting execution.  Modern  operating  systems for
personal computers work on batch serial basis without the use of spooling mechanism
4.  MULTI  -  PROCESSING  OPERATING  SYSTEM:  -  Multi  programming  system
executes  more  than  one  program  at  a  time  using  single  CPU.  But  in  the  multi
processing system, one program is processed by more than one CPU. This is useful
when one has to support both batch processing and many remote terminals. 
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DOS stands for Disk operating system. DOS is a set of programs and instructions
which are prepared to operate the computer and to use it for data processing is called
a program.
The MS-DOS is having two types of commands to proper execution of programs. They
are “internal” and “external” commands.
INTERNAL COMMANDS:  -  All  the  internal  commands are  included in  one of  the
system  files  i.e.,  command.com.  Once  the  computer  system  is  booted,  the
command.com is loaded into primary/ main memory of the computer and remains
there until the system is switched off.
1. DIR: - Dir stands for “Directory”. It means this command list out all the directories
which are created by users in the hard disk or floppy disk.
Syntax 
C: \>dir
The other options of Dir commands

a) Dir/p: To get the directories page wise, i.e one screen at a time, this command
is used.

b) Dir/w: To get the directories in width wise this command is used.

2. CD or MKDIR: - This command stands for ‘making a directory’. This command is
used to create a new directory.
Syntax          C:\>MD or MKDIR

Example       C :\> MD Students

3. CD: - This command stands for “change directory”. So with help for this command
we can move from one directory to another.
Syntax:         C:\> CD <directory name>

Example      C:\>CD students

4. CD. Or CD\:- This command is used to go back to root directory.

Syntax:    C:\ >CD... or CD\

5. RD: -  RD stands for  “Remove directory”.  This command is used to  remove the
existing directory from memory which is not useful in future.
Syntax:       C :\> RD<sub directory name>

Example    C:\>RD marks

6. COPY: - This command copies a file from one file to another file.

Syntax      C :\> COPY <source file> <destination file>

Example   Copy Mahesh  mahi
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7) What is DOS? Explain in detail.
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7. COPY CON: - This command is used to create a file in a directory.

Syntax       C:\COPY CON <File name>

Example    C :\> COPY CON BS.c

8. REN: - REN stands for ‘rename’ that is to change the name of existing file and give
new name to that file, this command is used.
Syntax :     C :\> REN <existing file name> < Name file name>

Example :  C:\>REN students  Mahesh

9.  DEL:  -  DEL  stands  for  ‘delete’.  This  command  is  used  to  delete  created  file
completely from the memory.
Syntax       C:\>DEL <File name>

Example    C:\> DEL Mahesh

10. CLS: - CLS stands for ‘Clear screen’. By using this command we can clear the
monitor screen.
Syntax:    C :\> CLS

EXTERNAL DOS COMMANDS
Some commands are  do  not  need  to  be  loaded into  memory  every  time you boot
because they are not used frequently or they are large and take up large amount of
memory space. Hence, they are stored as separate files in the DOS directory. Such
commands are called external commands. 
1. BACKUP: - This command is used to make back up copies of the mentioned files or
all the files in a directory or drive.
Syntax    C:\>BACKUP C

2. RESTORE: - This command restores all files which were backed up previously

Syntax    C:\>RESTORE A:C:

3. ATTRIB: ATTRIB stands for ‘Attribute of a file’. This command is used to change the
attributes of a file. That is to hide a file or to make it read only or vice versa.
Syntax    C:\>ATTRIB <File Name> [+h] or [-h] or [+r]  or [-r]

Attributes:
[+h] = To hide a file [-h] = To display a file.
[+r] = To make writable a fiel [-r] = To make read only a file.
4. CHKDSK: - CHKDSK stands for ‘Chek disk’ . This command is used to check a
disk’s formatted size and available memory space.  It  indicates the amount of disk
space consumed by system files, data files and bad sectors etc.
Syntax   C:\> CHKDSK C

5. DISKCOPY: - This command copies entire floppy disk track by track into another

disk. Syntax  C :\> DISKCOPY A: B:
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6. FORMAT: - This command is used to format a new disk.

Windows is an operating system, a product of  Microsoft  Corporation,  USA. It  is  a
graphical  user  interface  (GUI)  which  has  been  designed to  make  your  work  more
interactive  and  easy.  There  is  no  more  need  of  remembering  the  exact  system of
commands to get your work done, like in MS DOS. Everything is provided in the form
of  pictures  and graphics.  So,  the  program files  and other  resources  are  generally
accessed with the help of a special input device called Mouse.  
FEATURES OF WINDOWS

1. It provides a graphical operating environment. All the programs and resources
are provided in the form of icons.

2. It  is a full-  fledged operating system with an in-built  copy of  DOS. i.e  DOS
programs are also can be run safely run on windows.

3. It  is  a  multi-  tasking  operating  system,  which  means  that  more  than  one
application can be made to run simultaneously.

4. It support long file names up to 255 characters thus breaking the DOS naming
convention where you can give primary file name up to 8 characters.

5. The  plug  and  play  feature  of  windows  automatically  adapts  itself  to  the
hardware it is running on. It can detect hardware and then install the proper
drives all without taking any help from you.

6. It  contains  several  in  –  built  application  programs  and  system tools  as  its
accessories.  These  accessories  of  windows  can  be  used  to  fulfill  the  user
applications.

WINDOWS VERSIONS
 The windows OS is developed by ‘Microsoft Corporation’
 It is a GUI Operating System
 It is a Single User – Multi tasking Operating system, So, the user can run Multiple

tasks at a time
 When designing  this OS, Microsoft has taken 2 separate approaches

 One is for home users 
 Other is for IT professionals

 The first version of windows ( version 1.0) was released in November 1985.
 In 1987 version 2.0 was released
 In 1990, version 3.0 was released
 In July 1993, windows NT was released 
 In June 98 Windows 98 was released 
 In February 2000 , Windows 2000
 In October 2001, Windows XP 
 In 2009 Windows 7,was released

Features of Windows OS:-
 Multi tasking
 Plug and Play facility
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 Help Facility  Searching and Internet Accessing

Windows is the most popularly used operating system. It is developed by Microsoft
Corporation.  Windows  has  been  designed  on  the  concept  of  GUI  (Graphical  User
Interface). 
Desktop  :    
Desk top is the first screen that we see when a computer is switched on. It has several
components such as start button, Task bar and icons. 
Start button: It is the most important button on the desktop. When you click it, we
get a menu called start menu which shows various programs stored in our computer.
Taskbar:  The rectangular bar that runs horizontally across the bottom of screen is
called taskbar by default.It  provides access to  the all  programs.  It  includes start
button, current time etc.
Icons: The pictures on the desktop are known as icons. These icons can be arranged
in any order in the desktop. We can open an application by simply double clicking on
the icons.
Icons on the desktop:
My Computer: This is a standard icon and very useful, it contains all the resources
available  in  the  computer.   Generally  it  consists  of  all  the drives  available  in  the
computer.   
My Documents: The My documents icon links to a standard folder, where windows
uses to store the documents, by default windows will saves any documents we created
in this folders.
Internet Explorer:  This icon is a shortcut to  Microsoft  internet explorer program,
internet explorer is used to view websites and web pages.
My Network Places: This Icon represents a folder that contains links to any other
computers that are in workgroup.  The contents of network are workgroups, servers,
share folder and printers.
Recycle Bin: All files and folders, which are deleted from the windows, are stored in
the recycle bin. Recycle bin can be used to restore files that have been detected.\
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Explain in detail Windows basics:
Explain about the concept of entering windows

What is control panel? Explain.
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The control panel is a part of the Microsoft windows graphical user interface which
allows users to view and manipulate basic system settings and controls via applets,
such as adding hardware, adding and removing software, controlling user accounts,
and changing accessibility  options.  Additional  applets  can be  provided  third  party
software.

Unit III
Microsoft Word

Introduction to MS Office 
MS Office stands for Microsoft Office. Microsoft  office is a program or software that is
used to do various types of official works such as making presentation, writing letter
and data entry etc. it is a combinations of MS word, MS excel, MS PowerPoint, MS
access, MS Outlook, MS publisher etc.

Word processing package is widely used application package. It is used to create, edit
and format textual documents. It is mainly used to create documents such as letters,
reports  and  file  cover  sheets.   A  number  of  features  are  available  in  the  word
processing package Such as  Word Wrap, Editing, Spell Checks, Grammar Checkers,
Thesaurus, Find and Replace etc.
Features: 

 Text can be typed on computer screen without paper. 
 We can easily edit text.
 Change the appearance of a document.
 Produce a paper copy.
 In the existing file, more work can be inserted, deleted or upgrade.
 We can arrange paragraphs.
 Paragraph settings, right, left margins, line spacing, top margins, bottom 

margins can be fixed as specified by user.  
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1) What is MS Word? Explain its features.
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 Paragraph or text of any document can be copied or moved within the 
document or outside the document.

  Spelling can check and corrected.
 Synonymous of the given word can be used and text can be made more 

effective. 
 Words can be searched and replaced.
 Merging more than two files is possible.
 Documents can be used more efficiently by using drawing tool and color tool.
 Same letter can be printed with different names and address by using mail

merge option.
 Clipart is present for picture addition in document.

          
How to start MS-Word:
Step 1: Click on start button and select programs.
Step 2: Select the Ms-Office.

Step 3: Select the MS-Word.
Double click on short cut icon of MS-Word is present on the desktop.  (OR)
Start àRunàType “Winword”.

The Microsoft Office Button
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2)  Explain the parts of word window (or)
Write about different types of MS Word window components.
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The upper-left corner of the Word 2007 window is the Microsoft Office button. When
we click the button, a menu appears. We can use the menu to create a new file, open
an existing file, save a file, and perform many other tasks.
The Quick Access Toolbar
Next to The Microsoft Office button is the Quick Access toolbar. The Quick Access
toolbar provides frequently used commands. By default Save, Undo, and Redo appear
on the Quick Access toolbar.
The Title Bar
Next to The Quick Access toolbar is the Title bar. The Title bar displays the title of the
current  working  document.  It  contains  three  buttons  such  as  Minimize,
restore/Maximize and close buttons.
The Ribbon
In Microsoft Word 2007, we use the Ribbon to issue commands. The Ribbon is located
near the top of the screen, below the Quick Access toolbar. At the top of the Ribbon
are several tabs. 
Clicking a tab displays several related command groups. Within each group are related
command buttons. We may also find a dialog box launcher in the bottom-right corner
of a group. Clicking the dialog box launcher gives you access to additional commands
via a dialog box.
The Ruler
The ruler is below the Ribbon. We can use the ruler to change the format of your
document quickly. If the ruler is not visible, do the following steps:

 Click the View tab to choose it.
 Click the check box next to Ruler in the Show/Hide group. 
 Then the ruler appears below the Ribbon.

The Text Area
Text  area  is  nothing  but  just  below the  ruler  is  a  large  area.  You  can  type  your
document in the text area. The blinking vertical line in the upper-left corner of the text
area is the cursor. 
The Vertical and Horizontal Scroll Bars
The vertical and horizontal scroll bars permit you to move up, down, and across your
window simply by dragging the icon located on the scroll bar. The vertical scroll bar is
located along the right side of the screen. The horizontal scroll  bar is located just
above the status bar. 
The Status Bar
The  Status  bar  appears  at  the  very  bottom  of  your  window  and  provides  such
information as the current page and the number of words in your document. 
Understanding Document Views
In Word 2007, we can display our document in one of five views: Print Layout, Full
Screen Reading, Web Layout, Outline, and Draft.
Print Layout
The Print Layout view shows the document as it will look when it is printed.
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Reading Layout
Reading  Layout  view  formats  your  screen  to  make  reading  your  document  more
comfortable.
Web Layout
Web Layout view enables you to see your document as it would appear in a browser
such as Internet Explorer.
Outline View
Outline view displays the document in outline form. You can display headings without
the text. If you move a heading, the accompanying text moves with it.
Draft View
Draft view is the most frequently used view. You use Draft view to quickly edit your
document.

How to create a new document:
Creating a new document (Ctrl + N)
To open a new file just follows these steps: 
Step 1: Click on office button.
Step 2: Click the new option.
Step 3: Click create button from side pane.
Now the new document comes in front of us.
How to save a document    (Ctrl + S) 
Save option is used to store the file in the computer, following these steps.
Step1: Click on office button
Step2: Select Save option.
Step3: Type the name of the file in the text box.
Step4: Click the save button.     
How to close a document: (Ctrl + W)
After completion of typing a document, i.e. after saving the document, we should close
the document window. To close the window, select the ‘close’ command in the ‘Office
button’ (Office button close). Before close the document window you must  save the
document and close. But continue to work with word.

How to open a Preexisting document?   (Ctrl + O)
It is used to open the existing file, which is saved.
Step 1: Click on office button.
Step 2: Click the open option
Step 3: Select the file from the open dialog box.
Step 4: Click the open button. 
How to exit to word
The exit command lets you save document and quit word. Following these steps.
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3) How to create, saving, closing, opening, and exit from a word document?
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Step1: Click on office button.
Step2: Click exit command.

Editing a document means changing an existing document. Word processing features
several methods for erasing and retyping the text quickly.

Inserting text

Word  offers  several  ways  to  insert  new text  into  an  existing  document,  the  main
approach is to move the insertion point to the desired location and start typing.
     You start by placing the mouse pointer (the I-beam) where you want to begin
inserting text. 

Deleting Text

Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will
delete text to the left of the cursor and Delete will erase text to the right. To delete a
large selection of text, highlight and press the DELETE key. 

Undo:-  (Ctrl+Z)

This option is used to correct the mistakes, last to first from where the document
started. 

Click the undo button on the quick access tool bar. Or Press Ctrl + Z.

Redo: - (Ctrl+Y)

This option is used to redo or it plays the reverse option of undo command. Just follow
the below steps.

Click the Redo button on the quick access tool bar. Or Press Ctrl + Y.

Replacing Text

With word, you can combine the steps of deleting, positioning the insertion point, and
inserting replacement text. Highlight the unwanted text and start typing.
Cut Copy and Paste commands.
CUT: This option is used to cut the selected text in a document after cutting (copying)
the information, we can be paste any other place. 
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4. What is editing? Explain in detail Editing features in MS- Word.
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COPY: This option  is  used  to  copy  the  selected  information  into  clipboard,  after
copying the information, we can be paste any other place. 
PASTE: This option is used to paste the Clipboard data in the desired location in the 
document.   

Find and Replace

If we need to find a particular word or phrase in your document, we can use the Find 
command. This command is especially useful when we are working with large files. 
After you find the word or phrase you are searching for, you can replace it with new 
text by executing the Replace command.
To Find Text: Click the find button in the editing group on the Home tab.

 it will display Find and Replace dialog box.

 Type the text that you want to search in “Find what” text box.
 Click on Find Next button to start searching.

To Replace Text: Click the Replace button in the editing group on the Home tab.

 it will display Find and Replace dialog box.
 Type the text that you want to search in “Find what” text box.
 Type the text that you want to replace in “Replace With” text box.

 Click Replace button to replace text (OR) click Replace All button 

Formatting refers to the way our text will look like - the design of the characters, their 
size, the space between paragraphs, their alignment, etc.
First, selection of text.

 By using the mouse, position the insertion point at the beginning or end of the
block to be selected and then click and drag to the end or beginning of the
block.

By using the shortcuts:
 Double-click on a word to select it.
 Triple-click on a paragraph to select it.
 Ctrl + click on a sentence to select it.

There are basically two types of formatting:
 Character formatting, and
 Paragraph formatting

Character formatting
Character formatting is the one which we can apply to any individual character or to a 
group of characters. It has the following options.
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Font: This decides the appearance of our characters.
Font Style: We can make characters stand out by making them Bold, Italic or both.
Font Size: This increases/decreases the size of the characters. The size measured in 
points (72 points =1 inch).
Font Color: We can apply colors to the characters for printing the final document.
Underline: We can draw attention to some particular text by underlining it.
Effects: We can also apply effects to our text. Two most common ones are Superscript 
and Subscript. The 2 in 32 is a superscript. To make a character into superscript, we 
need to select only that character, and click the box against Superscript. Similarly, 1 in
T1 is a subscript.
Paragraph formatting
This includes involves line spacing, paragraph spacing, alignment, indents, tab stops,
borders and shading. It provides the following options
Alignment: Text can be aligned to the left, center, or right side of the page or it can be 
justified across the page..

Alignment Description
Left Alignment All the lines of the paragraph will be aligned on the left.
Right Alignment All the lines of the paragraph will be aligned on the right.
Center Alignment All the lines of the paragraph will align to the center.
Justify The left as well as the right side of the paragraph will be

aligned except for the last line.

Indentation (Increase/Decrease Indent: Indents are the left and right boundaries of
selected paragraphs within a d o c u m e n t. T h i s ma y b e necessary when different
paragraphs have different left and right boundaries. 
Spacing: This option allows us to have some space before and/or after a paragraph or
a group of paragraphs. 
There is also a Line spacing option, which decides on the spacing between the lines of
the paragraph. 
Highlight Color - Use this option to change the color behind a text selection. The color
shown on  the  button  is  the  last  color  used.  To  select  a  different  color,  click  the
arrowhead next to the image on the button.
Text Color - This option changes the color of the text. The color shown on the button
is the last color chosen. 
Tabs and Tab Stops:-  Tabs are used to align columns of text accurateluy or create
tables. Tab stop is a position on screen and in document, which is the stopping point
for the Tab key on the keyboard. 
Document formatting:- This includes the size of page, its orientation, and headers or
footers. This page size and orientation can be set up as per the requirements of the
paper. Headers and footers are lines of text that run along the top and bottom of every
page.
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Printing our Document: By the name itself, this option is used to print the document
just follow these steps.
After completion of document composing, before printing we will see the preview by 
going to the Microsoft Office Button and then Print Preview.
The ribbon at the top of the page will look like this:

 Print brings up the print dialog box. 
 Options bring up the word options which are housed under the Microsoft Office 

Button. 
 Size allows you to pick the paper size you want to print on. 
 Zoom opens a dialog box which allows you to make choices. 
 100% makes the page the same size as an actual piece of paper. 
 One Page and Two Pages allows you to view one or two pages at a time depending 

on what you are clicking on. 
 Page Width allows to zoom the preview to fit the width of the window. 
 Ruler shows the ruler around the top and side of the page. 
 Magnifier changes the cursor into a magnifying glass so you can zoom in and out. 
 Shrink One Page tries to make your total number of pages less by one by reducing 

font size. 
 Next and Previous Page allows you to move forward or back through the preview 

of your item. 
 Close Print Preview closes the print preview and takes you back to the normal 

view.

To print without previewing first
Step 1: Click on office button.
Step 2: Select the print option.
Step 3: A print dialog box will appear. 
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The Page Range section allows you to choose what to print. Select All to print 
everything. 
Current Page to print only the page your cursor is currently on. 
Selection to print only the area you highlighted prior to going to the print screen. 
Pages to print only the page numbers you want printed. Use a combination of dashes 
and commas. (Example: 1,4,6-8,10,13-15) 
Step 4: Click print button. 
Now the document will be printed .Before using this check whether the printer button 
is on or off.

 A header is text that is added to the top margin of every page such as a document
title or page number and footer is text added to the bottom margin.   

 We can use headers and footers to print something simple on each page (such as
your  name)  or  something  complex  (such  as  graphics)  stylized  text  dates,  and
automatic page numbering can all be included in headers and footers.

Follow these steps to add or edit headers and footers in the document.
To insert a header or footer in a document
1. On the Insert tab, in the Header & Footer group, click the Header or Footer button.
2. In the Header or Footer gallery, click the style you want to use.
3. In the placeholders, type the text you want.
4. On the Design contextual tab, in the Close group, click the Close Header and Footer
button.
To insert only a page number
1. On the Insert tab, in the Header & Footer group, click the Page Number button.
2. Point to a position option in the list, and in the gallery, select a page number style.
To change the format of page numbers
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1. On the Insert tab, in the Header & Footer group, click the Page Number button, and
then click Format Page Numbers.
2. In the Page Number Format dialog box, click the Number format arrow, and then in 
the list, click the number format you want.
3. Select any other options you want, and then click OK.

A table is a collection of rows and columns. It is used to arrange text in columns and
rows. The intersection of a row and column is called a cell. Each cell is independent
and can be resized or formatted. We can insert text, numbers, pictures or formulae
into a cell. 
We can Use tables to create various documents like student details, forms, television
scripts, financial reports, parts catalogs and resumes.
Creating tables:
A table can be inserted anywhere in our document. A table can be created generally 
two ways:
Insert Table 
Draw Table 
Insert Table: 
Click the Insert on the Ribbon. Click the Table button in the tables
group Drag the mouse along the grid, highlighting the number of rows
and columns for the table. (Or)
Click the Insert Tab on the Ribbon, click the Ta ble button in the tables

group, and select insert table from the menu.

Draw the Table

A table can also be drawn onto the document:

 Draw the table by selecting Insert TabClick on Table button and
select Draw Table from the menu bar. 

 The cursor is now the image of a pencil and the Tables and Borders toolbar has
appeared.

 Draw the cells of the table with the mouse. If you make a mistake, click the
Eraser button and drag the mouse over the area to be deleted. 

 To draw more cells, click on the Draw Table button . 

SNO Name of the Student Group Address
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Working with tables:
Entering Text into Table:

 A table is created; we can type text in any cell of the table.
 When we press ‘Enter’ key in a cell, the row is expanded.
 To move to the next cell in the table, press Tab key.
 To move backward, press Shift + Tab key.

To insert a Column or Row: 

Click the  Layout tab under Table tools  and use commands located in the Row &
Column group.
To Delete a Column or Row: 

Select the Column or Row we want to delete, Click the Layout tab under table tools,

Click the  Delete button in the rows & Columns group,  and select  an appropriate
option from the menu.
To adjust Column width or Row height: 
Select the column or row we want to adjust, Click the Layout tab under table tools,
and use the commands located in the cell size group.

Borders and shading can be applied to both paragraph of text or to the tables. You can
select any line style, any line color and any width from the drop-down style, in borders 
and shading dialog box.
To add a border or shading to a paragraph

 Click the Page Layout tab on the ribbon.
 Click  on  the  Page  Borders  on  the  Page

Background group.
 Then  Borders  and  Shading  dialog  box  will

appear.
 In the  Borders  and Shading  dialog box,  on

the Page  Borders  tab,  click the icon of  the
border style you want to apply, and then click
OK.

 In the  Borders  and Shading  dialog box,  on
the Shading tab, click the Fill arrow, click the
shading color you want, and then click OK.

To insert a symbol

ICT Prepared by Mahesh MCA

9. Write short notes on Borders and shading. 

10. How to insert symbols, shapes, word Art, Page Numbers and equations. 



ICT – I          Computer Fundamentals and Office Tools                       39

1. Click where you want to insert the symbol. 
2. Click the insert tab on the Ribbon and click the symbol and click more symbols

in the symbol group.
3. In the Symbols dialog box, on the Symbols tab, select the font you want.
4. Scroll through the list of symbols until you find the symbol you want, double-

click it, and then click Close.
To insert equations

1. Click where you want to insert the equation. 
2. Click the insert tab on the Ribbon and click the equation and click insert new 

equation
3. In the design contextual tab select the required equation.
4. Type your equation in the equation box that appears in the document.

To insert a WordArt object
1. Click where you want to insert the WordArt. 
2. Click the insert tab on the Ribbon and click the Word Art button in the Text 

group.
3. In the WordArt gallery, click the style you want. 
4. In the Edit WordArt Text dialog box, type your text.
5. Set the size and other attributes of the text, and then click OK.

To draw a shape
1. Click the insert tab on the Ribbon and click the shapes button in the 

illustration group.
2. Then click the shape you want.
3. Point where you want the shape to appear, and then drag to draw the shape.
To group drawing objects
1. Hold down the ctrl key, and click each object you want to group.
2. On the Format contextual tab, in the Arrange group, click the Group button, 

and then click Group.
To insert only a page number

1. Click the insert tab on the Ribbon and click the Page numbers button in the 
Header & Footer group.

2. Point to a position option in the list, and in the gallery, select a page number 
style.

Checking spelling and grammar in a document after we finish typing and editing the
text  is  very  useful.  We  can  check  for  possible  mistakes  and  then  confirm  each
correction. 

 In Microsoft Word, On the Review tab, in the Proofing group, click the Spelling
& Grammar button.
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 In the Spelling and Grammar dialog box, click the appropriate buttons to 
correct the errors Word finds or to add words to the custom dictionary or 
AutoCorrect list.

 We can choose to Ignore Once, Ignore
All,  Add to  Dictionary,  and Change
once, Change All, or AutoCorrect with
the buttons on the right.

 Click OK when Word reaches the end of
the Spelling and Grammar check, and
then click Close.

 We can use one of the words suggested
by  the  word  processor  and  click
Change.

 Similarly,  the  grammar  mistakes  are
flagged by a wavy green underline. We can correct these just as we corrected the
spellings.

A thesaurus is a dictionary of synonyms, words and phrases that mean the same
thing  as  a  particular  word  or  phrase.  Microsoft  Word  equipped with  a  thesaurus
feature  that  enables  you to  look  up both  synonyms and  antonyms.  Using  Word's
thesaurus feature can help you add more variety to your writing and suggest words
and phrases that your readers can better understand than the words you're uncertain
of. 
To use the Thesaurus
1. Double-click the word you want to replace, and then on the Review tab, in the 
Proofing group, click the Thesaurus button.
2. In the Research task pane, point to the word you want to insert in place of the 
selected word, click the arrow that appears, and then click Insert.
 

Importance of mail merge
It is a good feature of the Microsoft word which combines the address database with a
form of letter to create a group of individual letters. 
Mail merge is wonderful package available in MS word which is very useful to print
letters, envelops, mailing labels etc. 
Suppose if you propose to call 100 candidates for interview. You have to type 100
letters  individually  and  manually  or  photocopying  with  in  original  letters  typed
manually. In this process we feel wastage of time and labor and the process will be
delayed. It may not complete within time.
Mail merge Definition
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It is one of the important topics in ms-word; the basic advantage of mail merge is to
send the same letter to multiple persons by giving different address. We can use
the concept of mail merge, which is an automatic process and completes the work very
easily and timely.

Mail merge applications

Form letter: - General and uniform letters. Circulars notices can prepare and merge 
with data source.

Envelopes: - Process of creating, designing, size, shape of envelopes can be made.

Label & catalogue: - Word allows size, specimen of label and catalog and creates 
labels, catalogues.

Creating mail merge with the following steps

Step 1: Select document type: 
Click the Mailings tab on the ribbon, click the start mail merge button in the start 
mail merge group, and select type of document we want to create.
Step 2: Connect document to a data source: 
In the Start Mail Merge group on the mailings tab click the select recipient button.
Step 3: Refine recipients: 
In the start mail merge group on the mailings tab, click the edit recipients’ list button.
Step 4: Insert merge fields: 
Position the insertion point where we want to insert the merge fields and use the 
commands found in write& insert fields group on the mailings tab.
Step 5: Preview our letters: 
In the preview results group on the mail merge tab, click the preview Results button.
Step 6: Complete the merge: 
In the finish group on the Mailings tab, click the Finish & Merge button and select an 
option from the list.

Unit-IV
MS-PowerPoint

Introduction to Microsoft     Power point     
Power point  helps is  used to  create,  update,  and sort  “slide  based”  professional  –
looking presentation materials, even if we are not graphic or graphic art designer.

Power  point  is  a  presentation  tool  helps  you  create  eye-catching  and  effective
presentations  in  matter  of  minutes  PowerPoint  allows  us  to  design  professional
presentations.
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Power point makes it easier to organize, illustrate and deliver your ideas professionally,
whether you are conducting a meeting or presenting at a conference.

1. Blank and-white overhead transparencies.

2. on-screen presentations 

3. 35mm slides or overheads 

4. outlines & handouts

5. color overhead transparencies

6. Computer screen and video slide shows complete with special effects.

7. Presentation file that you can send to coworkers for their review, even if they don’t
known power point.

8. Printed meeting handouts

9. Detailed speaker’s notes

10.Printed and onscreen presentation outlines.

Microsoft Power Point is a tool for making presentations. Following are some of the 
features of PowerPoint.

1. PowerPoint has the facility to create presentations by using slides.
2. It has various built slide layouts.
3. It has templates and wizards to help in creating presentation.
4. It has a number of editing features like copying, cutting, pasting, selecting, 

finding etc.
5. It has various formatting features like font size, font color, background color, 

texture etc.
6. It helps to insert pictures from clip art and other files.
7. It helps to display the data form of charts and tables.
8. Different sounds effects can be given to the slides.
9. There is a master slide which helps to copy the formatting features to other 

slides also.
10.Animation techniques can be applied to the slides so that special effects can be 

given.
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11.The PowerPoint has the facility to present the slides one after the other at the 
click of mouse or it can be displayed automatically.

12.Timing can be set for each slide for display when it is presented automatically.
13.It shows the presentation in various views like slide sorter view, out line view, 

normal view etc.
14.It has the facility to store and save presentation.
15.It has the special feature to import the data from other applications.
16.Power point helps to print audience handouts, speaker’s notes etc.

Following are some of the advantages of PowerPoint presentation.
1. PowerPoint helps to create presentations easily and quickly.
2. It is very user friendly, time saving and helps to create presentation without 

much training.
3. It has number of toolbars with various options to create a presentation.
4. The presentation can be run automatically or by the click of the mouse.
5. Editing the slides possible.
6. Formatting features help to make the appearance of the slides very attractive.
7. Animation to the slide is also possible.
8. Pictures, objects, charts etc. can be inserted.
9. Slides can be numbered and sorted in order.
10.Different views help to display the slides and do the necessary changes if 

required.
11.Templates and wizards help in easy creation of slides and presentation.

 

Terminology
Before going to start a new program we should know some buzzwords, here everything
we need to know about PowerPoint speak.
Slides  :   - We create and edit individual pages called slides. For instance, in a sales
presentation you might have a slide titled competition, another called pricing, etc.
Speaker notes: - When we are preset use speaker notes. They are usually printed on 
paper and can be exact text of the speech.
Handouts  :   - Handouts are paper copies of all or some of the slides to be given to the
audience. They can be one per page or reduced so that three or six fit on a sheet of
paper.
Presentation Files: - All the power point slides for a particular project are kept in a
single power point file called a presentation file. These presentation files are normally
end with the extension.PPT.
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Masters:-We can create masters (also called master slides) to hold information that 
will appear on multiple slides in our presentation.
Color schemes: - Power Point lets we define rules used for applying colors or shades of
gray to the various components of our presentation. For instance, we can specify a
slides background colors, the colors used for major headings, and so on.

PowerPoint Templates  :   - A power point template consist s of a master and a color scheme. Power
point comes with 160 predefined templates. For example, a slide was created with template that includes
a diamond – shaped graphic and changes the colors of headings and bullets.

Step1: Click on start button.

Step2: Click on all programs.

Step3: Click on Microsoft office.

Step4: click on Microsoft PowerPoint 2007.

The Microsoft Office Button
The upper-left corner of the Word 2007 window is the Microsoft Office button. When
we click the button, a menu appears. We can use the menu to create a new file, open
an existing file, save a file, and perform many other tasks.
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The Quick Access Toolbar
Next to The Microsoft Office button is the Quick Access toolbar. The Quick Access
toolbar provides frequently used commands. By default Save, Undo, and Redo appear
on the Quick Access toolbar.
The Title Bar
Next to The Quick Access toolbar is the Title bar. The Title bar displays the title of the
current  working  document.  It  contains  three  buttons  such  as  Minimize,
restore/Maximize and close buttons.
The Ribbon
In Microsoft PowerPoint 2007, we use the Ribbon to issue commands. The Ribbon is
located near the top of the screen, below the Quick Access toolbar. At the top of the
Ribbon are several tabs. 
Clicking a tab displays several related command groups. Within each group are related
command buttons. We may also find a dialog box launcher in the bottom-right corner
of a group. Clicking the dialog box launcher gives you access to additional commands
via a dialog box.
Slide Canvas: the main work area where you add your text, bullets and images.
Slides Pane: displays thumbnails of your slides or an outline of your presentation.
Task Pane: provides additional options for a task selected in the Ribbon.
Notes Area: includes speaker notes. These notes will not display onscreen while you 
present.
View Buttons: change the view or launch a slide show.

Blank Presentation 

A blank presentation provides no content and is empty. The user can use his creativity
in  selecting  color,  objects,  designs  etc.  and  create  a  beautiful  and  eye-catching
presentation, a slide layout window is displayed which helps the user in selecting the
layout and designing a presentation.

Using a Blank Presentation
Step1:  Click on MS Office button New to display the New Presentation pane.
Step2:  On the New Presentation pane, click on the Blank Presentation link.
This will  open a new presentation with no template.  You will  provide the content,
background, color scheme, text format, etc. 
Using a Design Template
Step1:  click on MS Office button  New to display the New Presentation pane
Srtep2:  On the New Presentation pane, click on the From Design Template link
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Step3:  The Slide Design pane will display on the right side of the screen with a 
variety of different templates to choose from
Step4:  Select the design of your choice from the Slide Design pane
Step5:  Click OK to begin working with the first slide in the Normal View.

Inserting slides
PowerPoint provides a selection of pre-defined slide layouts based on different types of 
content that you can use to quickly add content to the slides.
Step1: Click On the Home tab, in the Slides group, 

Step2: click New Slide option.
Step2: From the list of Slide Layouts, select the layout you want to apply to the new 
slide.
Step3: Now begin adding content using the placeholders in the layout.
Deleting slides:
Deleting option is sued to remove the slide from the presentation.
To delete a slide from a presentation, do the following:
Step1: Click On the Home tab, in the Slides group.

Step2:  click Delete option.

Clip Arts are professionally designed images that you can add to documents. You can
change the size, appearance, and location of clip art after it has been inserted into a
document.
These  clip  art  images  include  many  different  themes  such  as  animals,  people,
buildings, food, holidays, business, and more.
How to Insert a Clip Art Image
Step1: Click on insert Tab on the Ribbon and click clip art icon in the illustration 
group.
Step 2: Now it will display clipart pane in the right side window.
Step3: In the Search box, type a word or phrase the clip you want.
Step4: Click go option. PowerPoint displays the search results in the Select Picture 
List.
Step5: Click on the clip art image you want and click OK.
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How to Resize a Clip Art Image
Once you have added a clip art object to your slide, you can resize it to make it fit
better into your presentation.
Step1:  Click on the Clip Art object to select it.
Step2:  Put the arrow on one of the resize handles at the corner of the picture
until the cursor changes to a double-headed arrow.
Step3:  Depress the mouse button and drag the handle toward or away from the 
center to make the image larger or smaller. When you release the mouse button, the 
object appears in its new size.
How to insert 
How to insert picture:
Step1: Click on insert Tab on the Ribbon and click picture icon in the illustration 
group.
Step 2: Now it will display insert picture window.
Step3: Find the picture you want and click insert option.
How to insert audio File:
Step1: Click on insert Tab on the Ribbon and click sound icon in the media clips 
group.
Step 2: Now it will display insert sound window.
Step3: Find the sound you want and click ok.
How to insert video File:
Step1: Click on insert Tab on the Ribbon and click video icon in the media clips 
group.
Step 2: Now it will display insert movie window.
Step3: Find the movie clip you want and click ok.

Slide transitions are the animation-like effects that occur in Slide Show view when you
move from one slide to the next. You can control the speed of each slide transition
effect, and you can also add sound. 
Stpe1: Navigate to the slide you want to add transition

Step2: Click on animation tab on the ribbon and click transition to the slide group.

Stpe3: Now click the required slide transition.
Microsoft Office PowerPoint  includes many different types of slide transitions,) the
following:

1. No transition 2. Blinds Horizontal
3. Blinds Vertical 4. Box In
5. Box Out 6. Checkerboard Across
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7. Checkerboard Down 8. Comb Horizontal
9. Comb Vertical

Custom Animation is a set of effects which can be applied to objects in PowerPoint so 

that they will animate in the Slide Show Power Point.
How to apply animation to Text
Step1: Select the text. 

Step2:  Click the Animations tab. 

Step3:  In the Animation group, click the custom animation, then it will display 
custom animation pane in the right side.
Step4: In that pane click add effects option and then select the required action like 
entrance, emphasis, exit and motion paths.
Types of animations 
There are many different animation effects you can choose from, and they are 
organized into four types: 
 Entrance: These control how the object enters the slide. For example, with the 
Bounce animation, the object will drop onto the slide and then bounce several times. 

Emphasis: These animations occur while the object is on the slide and are often 
triggered by a mouse click. For example, you can set an object to spin when you 
click the mouse. 

Exit: These control how the object exits the slide. For example, with the Fade 
animation, the object will simply fade away. 

Motion Paths: These are similar to Emphasis effects, except the object moves 
within the slide along a predetermined path, like a circle. 

Unit-V
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MS-Excel
Introduction

 Excel is an electronic spreadsheet. Spreadsheet or worksheet stores information
in the memory of computer performs data manipulation and displays results 
quickly. 

 The spreadsheet application includes preparation of reports, investment 
analysis and production analysis.

 MS-EXCEL is used to perform 
o Financial analysis
o Sales analysis
o Profit and loss analysis
o Mathematical analysis
o Statistical analysis etc.

 MS-Excel  is  an  electronic  spreadsheet.  Spreadsheet  or  worksheet  stores
information  in  the  memory  of  computer  performs  data  manipulation  and
displays  results  quickly.  We  can  enter  data  into  the  worksheet,  perform
calculation and generate graphs and charts.

 Excel’s basic file format is a workbook.
 Excel worksheet can store huge amount of information as it has a number of 

rows and columns in a sheet.
 It has a number of menus and commands that help the user in creating a 

worksheet.
 It is user friendly with GUI representation and the processing is very fast.
 It has the facility to move within the document using the arrow keys.
 It has a number of formatting features to format the information in the 

worksheet.
 Each workbook can hold 255 worksheets.
 By default excel workbook contains three blank worksheets.
 An index tab bottom of the worksheet identifies each work sheet as sheet1, 

sheet2 etc.
 Worksheets are made up of cells arrayed in columns and rows.
 The rows are identified by numbers 1, 2….and the columns by letters like A, B,

C.

 Each cell has a unique address made up of the column and row tables like A1,
B6 etc.
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Microsoft Excel is a powerful spreadsheet application. The spreadsheet has integrated
three components i.e. worksheet, graphs and database. We can enter data into the
worksheet, perform calculation and generate graphs and charts.

Features of MS-Excel:
1.     Workbook: A Workbook is a collection of worksheets. A Workbook may contain

one or more worksheets. So, we can organize various kinds of data into a single
file.

2.     Worksheet: A worksheet is look like a table, which contains rows and columns.
Worksheet is also known as Spreadsheet.

3. What..  If  Analysis  : The worksheet  of  EXCEL is  designed to  perform What..If
analysis quickly. What...If analysis means, "Tryout various values for the formula
in the sheet.”

4. Charts: A Chart is a graphical representation of data. MS-Excel generate various
types of charts (graphs) based on the values of the worksheet. Line graphs, bar
charts, Pie charts etc. 

5. Database: EXCEL sheet look like a table. So we can perform various database
operations like sorting, filtering, subtotals etc.

6. Functions and Formulas:  The built-in formulas are called as  functions.  Ms-
Excel provides different functions for analyzing and manipulating data. Formulas
are used in simple calculations (Addition,  subtraction,  Multiplication,  Division
etc).

7. Auto-calculation: By using this feature, we can easily find out the sum, average,
maximum, minimum values of the selected cells, without giving any formula.  

8. Auto-Complete:  AutoComplete will try to figure out what we expect to type, once
we have entered a few letters.

9. Automatic: In  Excel,  the  change  in  the  value  of  the  cell  automatically
recalculates the whole worksheet.

10. Number Formatting: In EXCEL, we can display numbers in different formats
like currency, date, telephone numbers etc.
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11. Better  Drag-and-Drop: By  using  this  feature,  we  can  select  a  portion  of
worksheet by simply dragging a mouse.

Step1:- Click on start button and select programs.

Step 2:- Select the MS-Office 2007.

Step 3:- Select the MS-Excel 2007. 

Step4: Click OK.
Then it will display a window.
MS-Excel2007 screen displays several options to help you perform tasks efficiently.
Click on a tab to see a further explanation of what it does and how to use it.

The Microsoft Office Button
The upper-left corner of the Excel 2007 window is the Microsoft Office button. When
we click the button, a menu appears. We can use the menu to create a new file, open
an existing file, save a file, and perform many other tasks.
The Quick Access Toolbar

ICT Prepared by Mahesh MCA

2. How to start MS-Excel? And explain Parts of Excel window.



ICT – I          Computer Fundamentals and Office Tools                       52

Next to The Microsoft Office button is the Quick Access toolbar. The Quick Access
toolbar provides frequently used commands. By default Save, Undo, and Redo appear
on the Quick Access toolbar.
The Title Bar
Next to The Quick Access toolbar is the Title bar. The Title bar displays the title of the
current  working  document.  It  contains  three  buttons  such  as  Minimize,
restore/Maximize and close buttons.
The Ribbon
In Microsoft Word 2007, we use the Ribbon to issue commands. The Ribbon is located
near the top of the screen, below the Quick Access toolbar. At the top of the Ribbon
are several tabs. 
Clicking a tab displays several related command groups. Within each group are related
command buttons. We may also find a dialog box launcher in the bottom-right corner
of a group. Clicking the dialog box launcher gives you access to additional commands
via a dialog box.
Name box:  Displays the address of  the current active cell  where you work in the
worksheet.
Cell, Active cell and cell address: The area formed by the intersection of a row and 
column is called a cell. The cell with the cell pointer is called active pointer is called 
active cell. By default A1 is the active cell when excel workbook is opened.
Formula bar: Displays the address of the active cell on the left edge, and it also shows
you the current cell's contents.
Worksheet area: This area contains all the cells of the current worksheet identified by
column headings, using letters along the top, and row headings, using numbers along
the left edge with tabs for selecting new worksheets.
Sheet tabs:  Excel  2007 contains 3 blank worksheet  tabs by default.  Click on the
intended tab will go to the particular worksheet.
Status  bar: Reports  information  about  the  worksheet  and  provides  shortcuts  for
changing the view and the zoom.
Zoom control: Used to zoom the Excel screen in or out by dragging the slider.

Creating a new work book:
To create a new workbook when it is invoked and names it Book1 by default.
Step1: Click the Office Button, 
Step2: select New
Step3:  click create 
 Or 
Press ctrl + N.
Opening an existing Work Book:
To open an existing work Book, follow the below steps.
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Step1: Click the Office Button

Step2: Select Open
Or
Press Ctrl+ O
Saving a Work Book
Step1: Click the save button on the quick access tool bar
Or 
Press Ctrl+ S
To Save a Work book with different name
Step1: Click the Office Button
Step2: Select the save as button
Step3: Select the required folder and new name 
Step4: Finally click Save Button.
To Close a Work book:
Step1: Click the close button or press Ctrl + W
To Exit excel: 
Step1: Click the Office button

Step2: Click exit excel.

To Enter Data in excel
1. Click on the cell. 
2. Begin typing. (If you make a mistake. use the Backspace key) 
3.  Press Tab key to move the next cell. 
4. Press Enter key to go to the next row. 

Generally three types of data can be entered into worksheets:  -  

i. Text
ii. Numbers and
iii. Formulas.

Text Entry:

When the input starts with an alphabet in a cell, then it is treated as Text by MS-
EXCEL. The   text is left justified in the cell. We can edit the alignment of text using
formatting features.

Editing means changing default settings. You can edit data in your worksheet to copy, 
cut, remove data or update data.
Number Entry:
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When the input starts with a number in a cell, then it is treated as number by MS-

EXCEL. The number is right justified in the cell. We can change alignment of numbers

using formatting features.

Formula Entry:
Formula is a self defined instruction for perform calculations. A formula must begins
with a (=) equal   to symbol.

Editing is the process of modifying cells/worksheets and manipulating the entered 
data.

To Edit a Cell’s Contents: Select the cell, Click the formula bar, and edit the cell
contents. And press enter when you finish.

To clear cells contents: Select the cells and press the delete key. 

To cut or copy: select the cells and click the Cut or Copy button in the clipboard
group on the Home tab.

To Paste Data: Select the destination cells and click the paste button in the click
board group on the Home tab.

To copy using auto fill: Point to the fill handle at the bottom – right corner of the
selected cell, then drag to the destination cell.

To Move or copy cells using drag and drop: Select the cells you want to move or
copy,  position  the  pointer  over  any  border  of  the  selected  cell,  then  drag  the
destination cells. To copy hold down ‘Ctrl’ key while dragging.

To insert a Column or row: Right click the selected row or column headings to the
right of the column or below the row you want to insert and select insert from the
contextual menu.

To delete a column or row: Select the row or column headings and either right click
them and select delete from the contextual menu, or click the delete button in the cells
group on the Home tab.
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To insert comment: Select the cells where you want to insert a comment and click
the review tab on the ribbon. Click the new comment button in the comments group.
Type a comment, then click outside the comment text box. Point to the cell to view the
comment.

In Ms-Excel, Formatting means to change the default setting of row column, cell, 
worksheet etc. 

Formatting  Cells:►  Ms-Excel  provides  various  formatting  features  to  create  a

worksheet more impressive. They are,

 Alignment of cell values.

 Changing font, font size, colour etc.

 Showing borders to the cells etc.

Steps:

 In the Home tab  cells group, select Format option.

 It will display Row height, Column width: 

Change the row height: if you want to change “ROW hieght” in Excel follow the given 
steps

 1. Select   FORMAT  ROW HEIGHT
 2. It displays Row Height dialog box

           3. Enter Row height and click on ok button.
Change the column width: ► if you want to change “COLUMN Width” hieght in Excel 

follow the given steps
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 1. Select   FORMAT  COLUMN WIDTH
 2. It displays Column Width dialog box

3.  Enter Column Width and click on ok button.

Format Text: Use the commands in the in the font group on the home tab, or click 

the dialog box launcher in the font group to open the font dialog box.

Format values: Use the commands in the number group on the home tab, click the 

dialog box launcher in the number group to open the format cells dialog box.

To copy Formatting with Format painter: Select the cells with the formatting you 

want to copy and click the format painter button in the clipboard group on the home 

tab. Then select cells you want to apply the copied formatting to.

To change cell alignment: Select the cells and click the appropriate alignment 

button ( Align left, center, Align right) in the alignment group on the home tab.

To Add Cell Borders: Select the cell, click the border button list arrow in the font 

group on the Home tab, and select a border type.

To Add cell shading: Select the cells, click the fill color button list arrow in the font 

group on the Home tab, and select a fill color.

To apply a document theme: Click the page layout tab on the ribbon, click the 

themes button in the themes group, and select a theme from the gallery.

To insert header or footer: Click the insert tab on the Ribbon and click the Header &

footer button in the text group enter header text.
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Top add a new work sheet:      Click the insert work sheet tab next to the sheet tabs at 

the bottom of the program screen.

To delete a work sheet: select the sheet want to delete, click the delete button in the 

cells group on the Home Tab, and select Delete sheet. Or right click the sheet tab and 

select Delete from the contextual menu.

To Rename a work sheet: Double click the sheet tab, enter a new name for the work 

sheet, and press enter.

To Split window: Drag either the vertical or horizontal split bar ( located near scroll 

bars ) on to the work sheet.

To Freeze Pane: Place the cell pointer where you want to freeze the window, click the 

view tab on the Ribbon, click the Freeze Panes button in the window group, and select 

an option from the list.

To select a Print area: select the cells range you want to print, click the page layout 

tab on the ribbon and use commands in the page layout group, or click the Print Area 

Button in the page setup group, and select set print area.

To Adjust page margins, orientation, size and breaks: Click the page layout tab on

the ribbon and use the commands in the page layout group, or click the dialog box 

launcher in the page setup to open page setup dialog box. 

To Protect or share a Workbook: Click the review tab on the ribbon and use the 

commands in the changes group.

Cell  referencing: The  cell  address  is  known  as  the  “cell  reference”.   The  cell

referencing is used in formulas.  It can be a single cell address like G2 or a group of

cells such as G2:G10.

      The three methods of referencing cells are:
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1. Relative referencing

2. Absolute referencing

3. Mixed referencing

1. Relative Referencing:

Excel recalculates any formula, when formulas are moved. They automatically change

relatively  to  the  location  to  which  they  are  moved.  This  is  known  as  relative

referencing.

Example: Suppose, if the cell C2 contains the formula =A2+B2, whenever we copy this

formula to the next row i.e. C3 then the formula in C3 is =A3+B3. 

2. Absolute Referencing:

In absolute referencing the formula will not change relative to the position, when the

formula  is  moved  or  copied.  In  absolute  address  ‘$’  sign  is  used  to  indicate  the

absolute position of the cell address.

Example:  The formula using Absolute reference =$A$2+$B$2

3. Mixed Reference:   Mixed addressing is the combination of relative and absolute

address.

Example: 

$A10+$B10: Formula with absolute column reference and relative row reference.

                  While copying or moving the formula, Column A, B is fixed and row 10
varies.

A$10+B$10: Formula with absolute row reference and relative column reference.

                  While copying or moving the formula, Columns A, B vary and row 10 is
fixed.

Formula  is  a  self  defined instruction for  perform calculations.  A formula in  Excel

always  begins  with  an  equal  sign  (=).  The  equal  sign  tells  that  the  succeeding

characters  constitute  a  formula.  Excel  calculates  the  formula  from  left  to  right,
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according to a specific order for each operator in the formula. We can change the order

of operations by using parenthesis.

To enter a formula, follow the below steps:

 Click the cell in which you want to enter the formula.

 Type = (sign) or paste function (fx), excel inserts an equal sign.

 Press enter.

    The following rules should be followed during formula entry:

1) A formula must begin with a = (equal   to) symbol.
2) When  a  formula  begins  with  +  or  –  signs,  EXCEL  displays  equal  to  (=)

automatically.
3) A formula can contain up to 255 characters.
4) Spaces should not be used.
Example:

In the worksheet, column A contains 
six values.

Name box shows active cell address 
A8.  

Formula bar shows formula.

    =A2+A3+A4+A5+A6+A7

The result of the formula is available 

In the cell A8  :  258

Chart: A chart is a graphical representation of data in a work sheet. Charts make data
easy to read, understand and analyze. In Microsoft  Office Excel 2007 it  is easy to
create  professional  looking  charts.  We  simply  by  choosing  a chart  type,  a  chart
layout, and a chart style.

Creating Charts 
1. Select the range containing the data to be charted, including column or row labels 
to be added. 
2. Click on the Insert tab. 

ICT Prepared by Mahesh MCA

How to create charts in Excel? And explain chart terminology.



ICT – I          Computer Fundamentals and Office Tools                       60

3. Select a chart style from the ribbon: 

Components:
Axes: The term “axes” generally refers to the lines that run horizontally across the 
bottom of the chart and vertically along the left side of the chart. 
• The horizontal axis is called the x-axis or category axis. 
• The vertical axis, called the y-axis or value axis, usually runs up the left side of the 
chart, but can also appear on the right side (Y2). 

Legend: Chart legend is an area on chart that explains the data points on the y-axis. 
It also shows name of each data series. 

Data Series: A collection of data from the worksheet. 

Gridlines: Lines that extend from the tick marks across the plot area. Gridlines 
sometimes make it easier to interpret charts. 

Chart Text: Text within the chart. This text can either be attached or unattached. 
Attached text is linked to a chart object and moves if the chart object is repositioned. 
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